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Pré-requis :
e Savoir utiliser I'DE Eclipse est fortement conseillé mais pas indispensable
e Savoir installer et configurer Tomcat (non traité ici car hors de propos)
e Savoir utiliser Jade

e Ce document traite de la mise en place d'un environnement de développement, il ne doit pas
étre utilisé en production.
e Ce tutoriel repose sur le guide de WSIG (v2.1), notamment pour l'exemple MathAgent.

Distribution :
e JADE v3.6.1 - http://jade.tilab.com
o WSIG v2.1 - http://jade.tilab.com/community-addons.php

Logiciels installés dans ce tutoriel :
e Java Run Time Environment version 1.5 nécessaire (testé en 1.6)
Eclipse 3.4+ - http:/www.eclipse.org
Eclipse Web Tools Project (WTP) 3.0.3+
Java EE Developer Tools minimum installation

Subclipse 1.4.7+ - http:/subclipse.tigris.org

Apache Tomcat 5.5 - http://tomcat.apache.org

Etape 1 — Installation de Tomcat et Eclipse

Commencez tout d'abord par installer Tomcat 5.5. Sur Ubuntu, il est disponible dans les dépots
officiels. Pensez a désactiver son démarrage automatique via la commande

sudo update-rc.d -f tomcatb5.5 remove

Installez 1'Eclipse que vous voulez (http:/www.eclipse.org/downloads/). Nous utilisons la distribution

Classic dans ce tutoriel.


http://jade.tilab.com/
http://www.eclipse.org/downloads/
http://tomcat.apache.org/
http://subclipse.tigris.org/
http://www.eclipse.org/
http://jade.tilab.com/community-addons.php
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Eclipse Classic 3.4.1 (151 MB)
a The classic Eclipse download: the Eclipse

Release notes | Other downloads | Docum
Downloads: 1,095,515

. HOME PRIVACY POLICY TERMS OF USE
Lllustration 1: http://www.eclipse.org/downloads/

Créez ensuite un workspace vide dans Eclipse qui restera dédié au projet, et redémarrez
dedans.

Allez dans Help > Software Updates, puis ajoutez le site
http://download.eclipse.org/webtools/updates.

Installez Java EE Developer Tools (dans Eclipse Web Tools Project (WTP) 3.0.3). Notez
qu'Axis n'est pas nécessaire car il est fourni dans la distribution de WSIG.

Ajoutez enfin le site http://subclipse.tigris.org/update 1.4.x, et téléchargez Subclipse, qui vous

permettra d'avoir la gestion du SVN intégré.

Etape 2 — Récupération du projet

Faites File > New > Other... > SVN > Checkout Projects from SVN
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Cliquez sur create a new repository location

Ajoutez https://wsig-examples.googlecode.com/svn/trunk/.

Sélectionnez enfin wsig-examples-read-only (ou wsig-examples si vous avez les droits
d'écriture sur le SVN) et terminez.


https://wsig-examples.googlecode.com/svn/trunk/
http://subclipse.tigris.org/update_1.4.x
http://download.eclipse.org/webtools/updates
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Ce projet est de type Dynamic Web Project. Une fois le contenu du dépot téléchargé et le workspace
mis a jour automatiquement, Eclipse déclare une erreur :

"Target runtime Apache Tomcat v5.5 is not defined. wsig-examples Unknown Faceted Project Problem"

C'est normal a ce stade, nous définirons un serveur a 1'étape 4.

Etape 3 — Plateforme Jade et agents

Créez et démarrez ensuite les Debug Configurations suivantes en tant que Java Application :
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rundadePlatform

Project wsig-examples
Main class jade.Boot
Program arguments -gui

Cliquez sur Debug pour démarrer la plateforme Jade.

runMathAgent

Project wsig-examples

Main class jade.Boot

Program arguments -gui -container

"MathAgentl:com.tilab.wsig.examples.MathAgent (MathFunctions
false)" -name "WSIGTestPlatform"

Cliquez sur Debug pour démarrer l'agent MathAgentl, instance de MathFunctions.




runMathAgentPrefix

Project wsig-examples

Main class jade.Boot

Program arguments -gui -container
"MathAgent2:com.tilab.wsig.examples.MathAgent (MathFunctions
false second)" -name "WSIGTestPlatform"

Cliquez sur Debug pour démarrer l'agent MathAgent2, instance de MathFunctions.

runMathAgentMapper
Project wsig-examples
Main class jade.Boot

Program arguments -gui -container
"MathAgent3:com.tilab.wsig.examples.MathAgent (MathFunctionsM
apper true)" -name "WSIGTestPlatform"

Cliquez sur Debug pour démarrer I'agent MathAgent3, instance de MathFunctionsMapper.

Pour plus de détails sur ces agents, reportez-vous au guide de WSIG.
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Démarrage

Par la suite, les agents peuvent étre démarrés directement via la barre d'outils :
Debug > runJadePlatform

Debug > runMathAgent

Debug > runMathAgentPrefix

Debug > runMathAgentMapper




L'interface graphique de Jade Platform a dG apparaitre, et vous pouvez voir les 3 agents évoluant
dans 3 conteneurs différents. Ces agents peuvent étre lancés indépendamment les uns des autres.
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Hllustration 2: Interface graphique de Jade

Etape 4 — Ajout du serveur

Procédure

1. Passez en perspective JavaEE.
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2. Sélectionnez le projet wsig-examples dans la liste des projets

- ¥ wsig-examples [trunkfwsig-examples]
b ‘zgDeployment Descriptor: Wsig applics

B 98 |ova Resnlrces: sre

3. Créez le Debug Configuration de l'application (Debug > Debug As > Debug on server) :
choisissez Manually define a new server de type Apache > Tomcat v5.5 Server, cochez la
case Always use this server when running this project, et faites Next.



& Debug On Server -

Debug On Server
Select which server to use é
How do you want to select the server?

®]

(@ Manually define a new server

Server's host name:? localhost ]

Select the server type:
[ type filter text |

E Tomcat v4.1 Server

E Tomcat v5.0 Server

=] =

Publishes and runs |2EE Web projects and server configurations to a local
Tomcat server.

Server name: |Tomcat V5.5 Server at localhost ]
Senver runtime environment: [ Apache Tomcat v5.5 i ] Add...
fi : ;

(% always use this server when running this project

@ _ | mext=> |[ mEmish || cancel

4. Renseignez le chemin d'installation de Tomcat, /usr/share/tomcat5.5 sous Ubuntu 7.10, et
faites Next.
5. Ajoutez le projet wsig-examples aux projets configurés pour le serveur, et terminez.

& Debug On Server -, -

Add and Remove Projects ’

Madify the projects that are configured on the server

Mowve projects to the right to configure them on the server

Available projects: Configured projects:

& wsig-examples

@ < Back Einish ] [ cancel




Configuration

Dans la vue des projets, un nouveau projet est apparu : Servers. Il contient un dossier comprenant
les fichiers de configuration de Tomcat (les fichiers XML).

cocoma oomon ¥ —_ = - - —

[ Project Explorer i3 =R

q
1}
Ll o

¥ = Servers |
¥ [=Tomcat v5.5 Server at localhost-config
=| catalina.policy
[ catalina.properties
[ context.xml
K| server.xml
x| tomcat-users.xml
x| web.xml

= *;EJ, wsig-examples [trunk/wsig-examples]

b 'zg Deployment Descriptor: Wsig applicatiol

Pour savoir quels ports écoute le serveur, ouvrez server.xml. Par exemple, ma configuration par
défaut est la suivante :

<!-- Define a non-SSL HTTP/1.1 Connector on port 8180 -->
<Connector acceptCount="100" connectionTimeout="20000" disableUploadTimeout="true"
enableLookups="false" maxHttpHeaderSize="8192" maxSpareThreads="75" maxThreads="150"
minSpareThreads="25" port="8180" redirectPort="8443"/>

<!-- Define an AJP 1.3 Connector on port 8009 -->
<Connector enableLookups="false" port="8009" protocol="AJP/1.3" redirectPort="8443"/>

Vous pouvez changer les ports, les changements seront pris en compte immédiatement méme si le
serveur est démarré.

L'application wsig-examples est déclarée vers la fin du fichier :

<Context docBase="wsig-examples" path="/wsig-examples" reloadable="true"
source="org.eclipse.jst.j2ee.server-wsig-examples"/></Host>

La valeur de reloadable permet ici de propager les modifications immédiatement sur le serveur, ce
qui est tres pratique pour éditer et tester du code a la volée. Sans ce mécanisme, il faudrait packager
l'application dans une archive war et la déployer sur le serveur a chaque fois.

Etape 5 — Déployement et utilisation

Le serveur démarre immédiatement en déployant l'application aprés avoir été ajouté. L'agent



ControlWSIG est alors créé dans WSIG-Container. La console de WSIG apparait a l'adresse
http://localhost:8180/wsig-examples/ (variable selon le port utilisé), que vous pouvez aussi ouvrir dans
votre navigateur web habituel.
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‘sig applic:

WSIG Services List

MathFunctions

MathFunctionsMapper

second_MathFunctions

WSIG Configuration
o 1m0l || JADE WSIG
i agent Active [ STOP )
status:
LS il localhost
host:
JA.IE)E main 1098
port:
JADE
container WSIG-Container
name:
JADE
container 1200
local port:
JADE WSIG | P e | =
[ Problems | v Tasks | =1 Properties | 44 Servers ¥ Data Source Explorer | [ Snippets B console 53 m %% kb

Tomcat v5.5 Server at localhost [Apache Tomcat] fusr/libfjvmijava-6-sun-1.6.0.03/binfjava (31 déc. 2008 11:33:54)
31 déc. 2008 11:34:00,556 --> Start wsigs's registration from agent: ( agent-identifier :name MathAgent3@Chartreuse-One:1099/JADE :addresses (seqt
31 déc. 2008 11:34:00,798 --= Create new wsig service: WSIGService (name=MathFunctionsMapper, onto=math-ontology, mapper=class com.tilab.wsig.exam

Illustraﬁon 3: Console web deiWSIG

Utilisation

Les web services correspondants a nos v Bmwsig-examples [trun il
L, P 'zm Deployment Descriptor: Wsig application
agents sont listés sur la page Home dans

= % ]ava Resources: src

WSIG Services List. Les exemples de

i com.tilab.wsig
requéte SOAP sont dans le package il T

H com.tilab.wsig. examples

] = = =

src/com.tilab.wsig.examples.xml : S e e

24
i MathFunctionstestGetRandom.xml 2 28/12/

u¥y MathFunctions-testPrintComplex.xml 2

¥ MathFunctionstestSum.xml 3 28/12/08 1

\¥j MathFunctionsMapper-AbsComplexxml| 3 26
¥y MathFunctionsMapper-AbsStringString.xml =
3 MathFunctionsMapper-Add.xml 2 28/12/08 1

¥} MathFunctionsMapper-SumComplexxml 2 2&

¥} second-MathFunctions-testDiffxml 3 28/12/C

¥ second-MathFunctions-testMul.xml = 28/

b com.tilab.wsig.serviet



http://localhost:8180/wsig-examples/

Allez sur la page Test pour les faire fonctionner : le contenu du fichier XML a tester est a copier

dans SOAP request. 1l ne vous reste plus qu'a envoyer la requéte !

Pense-béte :

e Si le serveur répond que le web service n'existe pas ("Service xxx not present in wsig"),
vérifiez bien que l'agent correspondant est démarré.

e Si vous désactivez l'agent ControlWSIG via l'interface web et le réactivez, les autres agents
auront été arrétés. Lancez-les de nouveau (sans arréter le serveur), et rafraichissez la page

Home pour les voir de nouveau dans la liste.

Home - Test

.. WSIG Console :.
Home -Test |

i

Test page

‘ WebService url:

f_http:fflocalhost:Sl 80/wsig-examples/ws

SOAP request:

[<?xml version="1.0" encoding="UTE-8" 7>

|=spapenv:Envelope xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
s :xsd="http://www.w3.0rg/2001/ XM Schema"
'http://schemas.xmlsoap.org/soap/envelope/"

hFunctions"=

g
soapenv:encodingStyle="http://schemas.xmlscap.org/soap/encoding/ "=
<complex xsi:type="urn:complex's
<real xsi:type="xsd:float">4</real>

SOAP response:

|XmLns:xsi="http://www.w3.0rg/2001/¥MLSchema-instance "><soapenv:Body>
|<getComponentsResponse xmlns="urn:MathFunctions'><getComponentsReturn
xmins=""=<float xmlns=""=4.0</float=<float xmlns=""=5.0</float>

</gel
</s04

=

[ Send | Reset |

Lllustration 4: Test de requéte SOAP

Démarrage manuel

1. Démarrez la plateforme Jade

2. Démarrez les agents

3. Dans l'onglet Servers en bas de 1'écran, cliquez droit sur le nom du serveur, puis cliquez sur
Debug, ou démarrez directement wsig-examples dans le menu Run > Debug ou la barre

d'outils.



Arrét

Pour tout arréter proprement :
1. Cliquez droit sur le nom du serveur, puis cliquez sur Stop.

2. Arrétez Jade via l'interface graphique en faisant File > Shut down Agent Platform.

JADE WSIG ; ;

st s com. tilab.wsig.agent. WSIGAgent

WSIG |

wehservices || htto://localhost: 8180/ wsig-examples/ws

[E_( Problems (@ Tasks (E Properties | slu Se

ﬂﬂ Data Source Explorer IE Snippets
P PP

39 m || Server State Status

B 20: if' # Tomcat v5.5 Server at loce &= Debugging Synchronized
20:4 % wsig-examples Synchronized
9 me

,8:09

Pour plus de détails sur Jade et WSIG, référez-vous a leurs guides d'utilisation respectifs.
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